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* Mechanistic deconvolutions

*Virtual bioequivalence trials
*Synergy between DDDPlus™ and GastroPlus®
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e 5-year collaborative project with the FDA Office of Testing and Research
on the utility of GastroPlus™ Mechanistic Absorption Modeling (MAM)
and IVIVCs to predict complex absorption characteristics

— Goal is to facilitate drug product development by decreasing regulatory burden
through modeling & simulation
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 Working definition:

“A predictive mathematical treatment describing the relationship
between an in vitro property of a dosage form (e.g., the rate or
extent of drug release) and a relevant in vivo response (e.g., plasma
concentration-time data)”

FDA Guidance for Industry Extended Release Solid Oral Dosage Forms: Development, Evaluation, and Application of In
Vitro/In Vivo Correlations (1997)
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e Can we find a mathematical function that allows us to correlate the in vitro release data (on the

left) with the in vivo plasma concentration-time data (on the right)?

e |f we generate such a function, can we use that function to predict the plasma concentration-

time for different formulations with different in vitro release-time profiles?
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— To reduce cost burden associated with bioequivalence trials

— For dissolution method development:
e Which in vitro method best correlates with a deconvoluted in vivo profile?

[# B prsa150RRN W O pH S 1S0RPI I @ oH 1.2150 REN |

120

100
m @ = =| g
m

80 [m} |

Percent

&0
40

[m]
20 m
]

o

Time, h

— For formulation design:

— Establish dissolution specifications
* What is the acceptable variability in key parameters before we are no longer bioequivalent?
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How do | develop my formulation to produce an in vitro dissolution rate that will achieve bioequivalence?
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— Point-to-point relationship between in vitro dissolution and in vivo input rate
(can be linear or non-linear)

e Level B:

— Correlation based on statistical moment analysis (in vitro dissolution time
correlated with MRT)

e Level C:

— Single point relationship between a dissolution parameter (e.g., t50%) and
pharmacokinetic output (e.g., Cmax, AUC)
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Class Solubility Permeability IVIVC?
| High High Possible, .|f c.h'ssolutlon is rate
limiting step
. Possible, if in vitro & in vivo
I Low High . . .
dissolution are similar
" High Low Limited, 5|r-1ce- qbsorptlon is
rate limiting step
Not expected (unless
\Y; Low Low dissolution is identified as

limiting step)

SimulationsPlus

SCIENCE +SOFTWARE =SUCCESS



— In vitro dissolution data from batches teste
* Compendial methods

In vivo

— invivo C,(t) profiles for reference formulations
* |V, solution or IR doses — for building / calibrating the PK model

— invivo C,(t) profiles after CR dose
* Qutputs:

— Step 1 (“deconvolution”): to derive the in vivo input rate

— Step 2 (“correlation”): point-to-point correlation between in vitro
dissolution and in vivo input rate (bioavailability or dissolution vs time)
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Determine the in vivo bioavailability (F% - NOT dissolution or absorption) from
plasma concentration data

Traditional options:

— Model-dependent:

Based on mass balance among PK compartments
— Wagner-Nelson, Loo-Riegelman

— Model-independent:

Based on theory of linear systems analysis

— Numerical deconvolution
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 Output?

— Amount of drug reaching central compartment vs. time (systemic availability or F%)

— Does not tell us anything about how it got there:
* Was it all absorbed and some lost to first pass extraction?
* Was only some of it absorbed with little or no first pass extraction?
* Was the in vivo release/dissolution anything like the in vitro experiment?

* Assumptions:
— Drug obeys one-, two, or three-compartment open model (limitation — does not consider drug’s true
distribution)
— First-order absorption (limitation — not realistic)
— No saturable (nonlinear) absorption or clearance (limitation — what if drug is substrate for

enzymes/transporters?)
— Terminal oral plasma concentration-time points independent of absorption (limitation — what about colonic
absorption?)
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Inputs (in addition to the data required for the traditional methods):

— Physiological parameters
— Drug properties (solubility, Peff, logP, pKa, etc.)

Outputs:

A model that combines all available in silico, in vitro and in vivo information and provides:

— in vivo dissolution, absorption and bioavailability vs. time profiles
— Description of site dependent absorption
— Description of tissue contributions to first pass extraction
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Bioavailability
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* Modified from van de Waterbeemd, H, and Gifford, E. ADMET In Silico ; g
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Total amount dissolved
/ * Deconvolved profile from
mechanistic approach

+«— Total amount absorbed

«—— Total amount into portal vein

Total amount into systemic
circulation (bioavailability)

* Deconvolved profile from

traditional methods
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Fit the in vivo release profile
(using the Weibull function) for | | >
each formulation used in IVIVC

Find the in vivo dissolution versus time profile that best fits the plasma concentration-time data

Find one correlation
function to best fit in vivo
vs. in vitro release profiles
across all formulations
used in the IVIVC

File

Camrnents:

Deconvolved in vivo dissolution vs

time profile obtained using the

—Weibull Parameters

%aDoseRelaased = Mz x{] ﬂxm[_(r_n":l £2x [L_”“D
eased = Max - - enp) 90
Al A2

Weibull function (single or double _ i
T [time lag] [hls]:IU r g o
H Max [total released) [%):[39.933 v Fhal
or trlple) ax [total release Esn-
E 40
Double Weibull Fhase1 r;  Phase 2 rj 5 a0
f (fraction): (050557 v [045443 =
A [time scale] [his"b): |1.7935 v |41.47 v 20
b (shapek [077082 W [17357 @ 101
ol

T T T T T T T
050 200 400 600 800 10.00 12.00

Akaike Information Criterion [A1C] = [#Pts] * Log[0bj) + 2(HParameters] =-17.3843
Schwarz Criterion [SC) = [#Pts] * Log(Obj) + [#Parameters(Logl#Pts]) = -14.5991

F\nq Initial i Fit W’eibull Eene] oK. Time [hrs]
Estimates i Function = =

I Tabulated data loaded from:

R*2=0.9339
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 Find the correlation between the in

||F #  CR Slow-In Vivo Rel. v =—— W Fit

vitro dissolution profiles and the T2
deconvolved in vivo release: 1
— Linear 0.8

— Power function
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— Cubic polynomial

0 0.2 |:|'..4 |]'..E n.e 1 1.2
— Time shift/scale (currently available only with Fraction In Vitro Release
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Predict the plasma concentration-time profile using the IVIVC equation and in vitro
dissolution curve:

— Internal validation: use the formulations involved in the development of the IVIVC

— External validation: use the formulations NOT involved in the development of the IVIVC

Acceptance criteria:

— Internal validation:
* < 15% absolute prediction error (PE) for C. ., and AUC of each formulation
* <10% mean absolute prediction error (PE) for C,_, and AUC

— External validation:
* <10% absolute prediction error (PE) for C,,, and AUC
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Example:
Traditional (Loo-Riegelman) vs.
Mechanistic Deconvolution:
IVIVC Establishment &
Validation
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1 Internal Validation
(Study 1)
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Time (h)
Figure 1. Mean in vitro release of five ER formula-

tions of divalproex sodium used in development and
validations of IVIVC.

Dutta, et al, ] PHARM SCI, 2005, 94(9), 1949-1956

Reference formulation : Medium
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2)
3)
4)

5)
6)
7)

8)

comman

Explore the IV and CR records of the database with the instructor.
Run the Human CR Fast - PBPK record and notice the poor fit at early time points.

Use the Controlled Release Weibull menu item to fit a Weibull function to the in vitro dissolution. Then
optimize a single Weibull to get the mechanistic deconvolution of the in vivo release that best fits the Cp vs.
time profile.

Click on Modules (Optional) - 1 IVIVCPlus
In the Drug Records section of the In Vitro Data tab, click on Slow, Moderate, and Fast

Click on the In Vivo Data tab and you will see that the in vivo plasma concentration-time data for the selected
drug records with an .opd support file were also loaded

Go to the IVIVC tab. Only drug records with both .dsd and .opd. support files will be shown in the Drug
Records list. Click on the Slow, Moderate, and Fast drug records. Under Deconvolution Methods click on Loo-
Riegelman (2-compartment model). Under IVIVC Procedure select the Deconvolute Then Correlate option if
is not already selected.

SimulationsPlus
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ICK On The beconvolute button.

7) After deconvolution, you will see a plot of Fraction Absolute Bioavailability vs. Fraction in Vitro Release,
the Correlation Function frame will appear and Form Correlation button will be enabled. In the
Correlation Function frame you can select the correlation functions you want to try to fit to the data.

For this example, we will keep the Select All selection, so all the boxes are checked. All checked
correlation functions will be fitted to the data and the program will pick the best fit based on lowest
Akaike Information Criteria. Click on the Form Correlation button.

6) When the program is finished fitting all the correlation functions, the best fit is shown in the Status

window on the IVIVC tab as well as on the Fraction Absolute Bioavailability vs. Fraction In Vitro Release
plot.

7) The Status window gives the following information about the correlation (Rsq=R2, SEP=Standard Error of
Prediction, MAE=Mean Absolute Error, and AlC=Akaike Information Criterion).

SimulationsPlus
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Window. Under Drug Records, select Slow, Moderate, and Fast.

9) Click on the Start button to run the convolutions. When convolution is finished the observed and predicted
plasma concentration-time profiles using the correlation function for all selected drug records will be shown in
the plot and the validation statistics will be shown in the Status Window.

Note: Only drug records with an .opd support file are included in the mean absolute percent prediction error
calculation.

10) Perform a similar external validation using the Slightly Slow and Slightly Fast records?

11) Repeat steps (5-9) but choose Mechanistic Absorption Model under “Deconvolution Methods”.
12) Save the final IVIVC.

13) Close IVIVCPlus.
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SCIENCE +SOFTWARE =SUCCESS



24

[ﬁ GastroPlus(TM): Valproate.mdb (C\Users\Eva\Docum.\Train.\Germa.\Eva\Valpr.\}

S

File Edit Database Simulation Setup Controlled Release Tools | Modules (Optional) § Help

pka Table

Enzyme Table

Transporter Table

Diff. Coeff. [cm™24s » 1075]); I 1.0
Dirug Particle Density [9dmL): I 1.2

Particle Size: B=25.00, D=50.00

Compound T Gt Phyziology-Hum T 1 WIVCPlus(Th) aition T Graph
~Selected Compound 2 Optimization 3
14| 4 [Valpoichcid_4F7 2 ﬂﬂl = |51 Trans Time 3 Metabolism and Transporter N
IEurrent= 1; Total =6 hc‘.ar;g;i%iy 4 PKPlus(TM) +Hmg.
________________________ 5 PDPlus(TM)
':l’l 6 PEPKPIus(TM) 8
HD/ 7 ADMET Predictor(TM] 4 -
Daosage Iﬁ & DI ctive Permeability
Fam: 9 Additional Dosage Routes | enpee: LI
Subszequent Doses [ma): i—D Peff [omds x 1074] I 5.63
Diosing Irkerval [H: I—D Sim Peff #1074 [Human) I 563
Malecular Formula: I CEH1E02 Dose Volume (mL]: |—25|j Convert from User Data |
M alecular weight [g/mall: Iw pH for Reference Solubility: | 3.28
logP freutiall [ 261 @pH: [ Solubity [mg/mL @pH=3.28: [ 329 Biorelevant Solubilties |
Mean Precipitation Time [zec) I 900

Al properties are predictions from ADMET Predictor »7.2.0.0

pk.a Table | logD: Struct-6.1

Tendency Supersaturate=5SupSat; Likelibood of BBE Penetration=High; Pgp-Inhibitor=Mo [347%); Pop-Substrate=Mo [37%); DATP1B1-Inhibitor=Mo [97%);

Dizs Model: Johnzon FartSize-Sal OM | BileSak-Sol: OM | Diff: 0N H ConstRad: OFF | Precip: Time Ppara: OFF |EHI2: OFF |

A4
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Display and plot the in vitro dissolution data for
the selected drug records

1% IVIVCPIus(TM) \ﬁ =rne
File Objective Function Weigh?”
In ¥itro Data M Iniva Data T MIWC T Caonvolution
—~Drug Records:

Mumber of drug records 4 [ Select &l -
with .dsd suppart file: Human-CR-Slow @
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Hurman-CH-Fast

e abdr Ka@E

—Raw In ¥Yitro Release Data:
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Display and plot the in vivo oral plasma
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Select which drug records you want to use to
generate the correlation

File Objective Function Wes

In VitrnD}J//I/ InWivo Data I IVIVC ] Convolution

~Drug Recorfs ~Status Window:
[ 5elect Al - "
Hurnan CR Slow Ij‘
["1Human CR Moderate
Hurman CH Fast o
~Deconvolution Methods: ~Plot. —————— _
" Mechanistic Absarption Model [G astioPlus] Cursor Pos.: I | S @ E Y ‘ .g-. % E
" Numerical Decorvalution K-axis:
" Loo-Riegelman [F-compartrment rmodel) ISE|ECI Iterm ;l (l
_1

@ Loo-Riegeiman [2-compartment rmodel) —

Choose convolution method

[ Systeric Fraction
[ Fraction Absolute Bioay.
[ InViro Releaze

[ Area Under Curve [aUIC]

" wWagner-Melzon [1-compartment rodel)

~I¥IVC Procedure
& Deconvolute Then Comelate & Conelate Directly [1 Step)

Run the deconvolution first to analyze the
in vivo vs. in vitro profile —

Y-axis scaling:
Deconyvalute Conrelation Stop Sawve [WIWVE | " Logarthmic Scale * LinearScale [~ Hide Legend

Motes: -
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Eile  Objective Function Weighting
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Maotes: -
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Deconvolute
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File Objective Function Weighting
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Eile Objective Function Weighting

Dirug Record
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Virtual Bioequivalence Trials:
Reference vs. Test Products
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Populations are generated, not sampled from a database

— An infinite number of populations is possible

Subjects are generated by Monte Carlo sampling of selected parameters
within their defined distributions:

— Gut physiology parameters

— Pharmacokinetic parameters

— PBPK parameters

— Dosage form and compound parameters

Populations can be saved and reused for crossover studies

Covariation of model parameters is a complex issue:

— Population simulator algorithms have been updated in version 9.6 to better account for
the known physiological covariates
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'I_g Population Simulator

File / \

—-Parameters - Parameter Lawwer Lirnit kean Y alue Upper Lirmit ribLiticn

Clear Al Doze of Yalzartan [mg] 91.514 100 10927 3 Log-Hormal _I
- Frimary Permeability of ‘Y alzarfn [c|0.2043 naz 41328 51 Log-Hormal
Farticle Shape Factor of Valsdrtan |0.7513 1 1.33 10 Lod-Marmal
ek 2 Mean Drug Particle Radius offyals:| 18,783 25 33,275 10 Lod-Normal
Precipitation Particle Radiuz o Val:| 0.7513 1 1.331 10 Log-M armal
Add Select Precipitation Time of ¥ alsartad [sec| 676,18 300 1197.9 10 Lo Hormal
Feference Solubility of Valsarlan [r|0.0738 0.093z2 01307 10 Log-Marmal
Set Defaults Fraction Unbound in Erterocyles o 07513 1 1.33 10 Log-Marmal
Oral Transit Time of Yalzartanfh) | 0.1878 .25 03328 10 Lod-Hormal
Oral Cavity A5F Walzartan 07513 1 1.331 110 Log-Hormal
- Population — Duoderum ASF Y alzartan 2101 27965 3724 10 Lod-Marmal
Jejunum 1 ASF Walzartan 20672 275814 3.BE21 10 Log-Marmal
Set PEAR Jejunum 2 ASF Valsartan 2.0505 2.7294 36328 10 Lod-Hamal
lleurn 1 ASF Y alzartan 20273 26933 35914 10 Log-Hormal
Load Previous lleurn 2 A5F Y alzartan 1.933 2 6461 3522 10 Lod-Homal
lleurn 3 ASF Valzartan 1.9416 25843 34336 10 Lod-Homal
Create New Caescum ASF Y alzartan 00797 01081 01412 10 Lod-Hormal
Azc Colon ASF Yalzartan 0.1551 02064 02747 110 Log-Hormal
OralMucozatfalume [mL] 26296 358 4 6585 110 Log-Hormal
SalivaProductionP ate [rl/mi] 07513 1 1.3 10 Log-Marmal
Fraction of colan fluid volurmne fn Faz| 7. 5131 10 13.31 10 Log-M armal
Fraction of 5| fluid volume in fhsted| 30,053 40 h3.24 10 Log-Hormal
Small Intezsting Length [cm] 230,01 306.14 407 47 10 Log-Marmal
Caecum Length [cm] 99118 13193 17.553 10 Log-Marmal
Colon Lenagth [cm) 20,772 27.648 36,739 10 Lod-Hormal
Stomach Yolume [mlL] 34.931 4B.56 E1.972 110 Log-Hormal
Small Inteztine Radius [cm) 07513 1 1.331 110 Log-Hormal
Caecum Badiuz [om] 25433 3.3851 4 5056 10 Log-Marmal
Colon Radiug [zm) 1.8086 24073 3.2041 10 Log-Marmal
Stamach Tranzit Time (k] 01447 0.25 0432 20 Log-Marmal

Small Intesting Tranzit Time (k] 1.857 3.2088 h.5448 20 g-Marmal T
— - PR o Yn 4 - —_ maa - e L '

Mumber of Output Data Points | 300 0K | Cancel |
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Plasma Concentration (pg/mL)

&

i

i

-
A

b

Virtual Trial 200-Fed-Daneshmend 1984

v [0 20% O mean Cp W = Mean Cp [V m Observed Mean | “T_ BE Limits
v Probability 100 % [ Probabilty 95 % [ Probability 90 % [ Probability 75 %

[  ProbabityS0% |¥  Probabiity25% [  Probabiity 10 %

o ”

subjects

eGreen band is 90%
confidence interval

eLight blue lines are
probability contours for the
virtual population

*Pink bars are the 80 to 125%
BE limits or % CVs

SimulationsPlus
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-¥irtual Trial Resulis

Mean Cvz Min Max
FaZx | 99613 | 004152 | 93 45 | 93 651
FDp % | 97 679 | 031963 | 96.9 | 98 211
Fx | 79412 | R.2822 | £9.694 | 25,291
Cmax | 2.9066 | 16.466 | 1.6608 | 3.6761
Tmax | 3129 | 14717 | 24 | 45
AUL inf | 12.889 | 25.053 | 7.461 | 18.476
AUC tl 12.598 | 25997 | 7.3224 | 17.858
90% Confidence Intervals
Untransformed Ln-transformed Geom.Mean
Fax | 9360 --> 9963 | 9360 --> 9963 | 99613
FDp % | 97 &7 > 9779 | 97 57 -» 9779 | 97.6va
Fx | F7A7 > B08R | F7.B6E > 8078 | 79,303
Cmax | 2.743 --» 3.0 | 2.696 --> 3.046 | 2.8652
Tmax | 2971 > 3.287 | 2951 > 3253 | 2.0924
AUC inf | 11.78 --> 14.00 | 11.42 --» 13.65 | 12.488
AUC t | 11.55 --> 13.64 | 11.22 --» 13.33 | 12.229

36

 Upper Table (mean)

— Green means that the
simulated 90% Cl is within
the 80 — 125% BE limits.

 Lower Table (Geom.
Mean)

— Green means that the
simulated Geom. mean is

within the 80 — 125% BE
limits.

SimulationsPlus
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Bioequivalence trials are run to demonstrate bioequivalence between a test formulation and a reference
formulation.

To demonstrate bioequivalence, the test product must duplicate the Cmax and AUC of the reference
product within 80-125% at 90% confidence intervals under both fasted and fed conditions.

The number of subjects in the trial can affect the outcome. If the number of subjects is too small, the trial
might fail when the product is actually bioequivalent. If the number is too large, time and money are
wasted.

Virtual bioequivalence trials can help to predict whether a formulation is likely to pass or fail. They are
not perfect, but they provide an important decision-making tool to use with all other information.

What is the best way to run Virtual Bioequivalence Trials?
— Select the population parameters you want to vary and a number of subjects
— Run several virtual crossover trials to confirm a consistent trend between the Cmax and AUC ratios

SimulationsPlus
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Open the “Valproate” database in your Examples\Valproate folder

Navigate to the Human CR Test - PBPK record and review the model
parameters

— Test product is simulated first, then the reference is simulated, due to the order of
operations in the population simulator

Convert in vitro dissolution .dsd = to in vivo dissolution .crd

— see next slide

Calculate the Weibull function for the in vivo dissolution (.crd file) using the
Controlled Release>Weibull Function menu

SimulationsPlus
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Click File >Load—>3 Load In Vivo
Controlled Release vs. Time Profile (.crd)

Click Tools = Calculate CRD from IVIVC

Click Load .ivc file and load the correlation
we previously developed

Click OK to finish (return to .crd window)

Your newly converted dissolution profile is
now in the table.

:Z Calculate In Vivo R

File Units

Calculate In Vivo Release Profile from IVIVC

I Mo, of D ata Pointz I 2 C:\Uszers\Public\Simulations Plus,
InchG astroPlus9_0AE xamplezs\Intro\Y alproateAHuman CR Reference - PBPK dsd

I Coad e fie |
Laaded MIWCPILs Output File -
File created on 10/7/2016 at 5:24:25 PM by Jimi@JIk-PC 1.1E+24
Objective Function Weighting: 1/7hat™2
Decorvolution Method = kechanigtic Abzorption Model [GastroPlus) —_
Submethod = Dectonvolute Then Caorelate 2
=-0.078+1.847 + -0.800:"2 =
where x=Fraction released in vitro and p=Fraction releazed in vivo - = 52504
f:
Load dsd file | s
=
Time, h [%RelDSD [%RelCRD 0K = ik
0o 0o oo — g
1.0 £.1538 3263 =
a0 178462 22614 Cancel =
50 295385 397774 E 27.50+
9.0 480 B2.424 Cl @
ear
120 70,7692 02,8445 - ﬂ:a
180 100.0 6.9 =
240 100.0 96.9 Redraw 0.00g

] 1 ] 1
—_ 0.0 g.0 120 18.0 24.0
Time, h

Sort Data on Time |

Note: This is only sample figure — your profiles and CRD values will be different

SimulationsPlus
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In the .crd window click Fit Weibull Function
In the Weibull window:

Click Find Initial Estimates

Select Double-Weibull function
and Set f (fraction) = 0.5

Select parameters to be fitted
Click Fit Weibull Function

Click OK to close the Weibull window and return to
the .crd window

The fitted Weibull parameters will appear in
the Comments section of the .crd window.

Click File = Save As to write the new .crd file

E Weibull Controlled Release Profile

File

Comments:

—(F — T —fF — T ' F — Tyba 100
YaltoseReleased = Maxx (l-fiexpll (EAIT) }-fzexp{ (rﬂ:‘) -fgexp{ (‘Aan ]I) 20
~Weibull Parameters 80
Fit — 70
T [time lag) (hrs): Igi - Select Weibull Function: %
Max [total released) (%): [93933 ¥ [Dauble weibul | % ]
® 50 4
E 0]
Phase1 ; Phase2 ; Phaze3 ; g a0
F(fraction): [057033% W [4280603 [~ [0 20
A [time scale] [hrs™b): [1.756E+5 W |[g.785 vV N I~ 101
b(shape): [17324 [ [123@1 & |1 r o
g '1ID ‘1‘5 2‘0
Fing i Fit wieibul . - Time hrs]
shimates Function
|
R*2=09333

Akaike |nformation Criterion [AIC] = [(HPts) © Logl0bj] + 2(#Parameters]) = 26186
Schwarz Criterion (SC) = [#Pts] * Log(Oby) + [HParameters)[Logl#Ptz])) = 31747

Note: This is only sample figure — your profile and parameters will be different

SimulationsPlus
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un a Single Simulation for record Human es , make sure to selec
Weibull CR Profile Already in Memory” option

Select the Population Simulator option on the Simulation tab to open the Population
Simulator window

Set the CV% for Dose = 3%; keep all other CV% at their default numbers. Change the
Number of Output Data Points to 75

On the PEAR Population Simulator Settings window, define the age range to run from
21— 40 years old, with a 50/50 split between males & females

Set the Sample Size = 12 subjects (small pilot study) and click Start

Review the results

SimulationsPlus
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Case Study: Valproate BE

Navigate to the Human CR Reference - PBPK record
Convert in vitro dissolution .dsd = to in vivo dissolution .crd

Calculate the Weibull function for the in vivo dissolution (.crd file) using the Controlled
Release—>Weibull Function menu

Run a Single Simulation, making sure to select “Use Weibull CR Profile Already in
Memory” option

Select the Population Simulator option on the Simulation tab to open the Population
Simulator window

Click on the Load Previous population button on the left and select the 12-subject file
generated from the Reference product simulation. Set the CV% for Dose = 3%

Click on the Start button on the Simulation tab. When finished, navigate to the Graph tab
and click on the New Plot button

&8 SimulationsPlus
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Population Simulation: Human CR New Moderate - PBPK

||7-EZ::Z nean Cp [ = Mean Cp 2 ¥ ——lean Cp I
32+ TEST(T): Human CR New Moderate - PEPK-125ubjects
(C:yUsersh PublichSim. . \Gas. .\ Wor. . hExa. ... .8 )
30 REF(R): CurrentvT-Human CR Reference - PEPK-12Subjects
{(C:sUsersi\Publici5im. . Gas. . "\Wor. . A\ExXa. .. .. %)
284 Result cmax AUC AUCT
MeanT 27.22 1015.7 941.0
Meank. 29.98 1024.9 952.2
26' GeomMeanT 27.02 1010.8 937.3
GeomMeank.  29.76 1022.3 950.0
244 90% CI (MeanT-MeanR)
84,.743--»96. 837 94.721-->103. 47 94.775--»102. 87
224 {GeomMeanT,/GeomMeanR.]) =100
90.82 98. 98. 66
204 0% CI (GeomMeanT/GeomMeank])
85.271--»96.721 94,547 -->103. 4 94,6836-->102. 86

121
104

Plasma Concentration (ug/mL)

0 2 4 6 8101214 16 18 20 22 24 26 28 30 32 34 36 38 40 42 44 46 48 50 52 54 56 58 60 62 64 66 68 70 72
Time (h)
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Establishing Dissolution Specifications:
Mechanistic dissolution variability —
synergy with DDDPlus™

44 SimulationsPlus
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Synergy between DDDPlus™ and
GastroPlus®

e Design a formulation to simulate e Simulate PK profiles using predicted

in vitro dissolution or establish in vitro dissolution profiles (raw data
dissolution specifications /\ or Z-Factor model)

e Design an in vitro dissolution v

method using the deconvoluted in
vivo release curve as the “target”

e Deconvolute in vivo release using
measured PK data

45 SimulationsPlus
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virtual lots simulated in DDDPlus

Virtual Trial Slightly Slow

v Il 90°% C.|. mean dissolution [v
- Frobability 35 % -
- Probability 50 % I~

Mean Dissolution ¥ Probability 100 %
Probability 90 % - Probability 75 %
Probability 25 % - Probability 10 %

T T T T T T T T T T T T T
100 200 300 400 SO0 SO0 YOO 800 900 1,000 41,100 1,200 1,300 1,400
Time: {min}

Lawwer Linit | tean Value |

| Parameter |

Upper Limit__| Cyx |

Select
Parameters

¥ |HPMLC K15M Amt [ 2445 | 330 | 4455 | i |

46

profiles loaded into GastroPlus to predict PK

Predicted PK Profiles
35

30

0 8 16 24 32 40 48 56 64 72

Time (hours)
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simulation computer program that contains

equations to account for the following:

Dissolution rate for active pharmaceutical
ingredient (API) and excipients

Multiple particle size distribution for API
and excipients

Variety of dosage form models

Solubility-dynamic microclimate pH
calculation for APl and excipients

pH of buffers from composition of acids,
bases, and salt equivalents.

Selection of USP and biorelevant
experimental apparatus and conditions

Form I

Formulation Name
4| 4 |Hydrocan lisome Coarse Pow, )INILI

| Current Record: 1; Total Records: &

~Manufacturing Properties

Compression Force (kM): 35

Porosity/ T ortuosity: 0.5285
Tablet Diameter (mm): 1o

Cap. Dizsinteg. Time [min) o
Matriz Physical Tablet Manutacture
Dimensions Paramel ters

Suppaort fil
Hydracort] Coarse Powder psd
Hydracort; Coarse Powder. dsd

Ingredient Mame | Type | Amount |
Hydracort tisone Acti 150
pKa Table Edit Formulation

Forrnulatiorn T Dissolution Method T Simulation

| Hydrocort tizone Coarse Powder |

=

~Dissolution Parameters

Medium Type: |IEE] d
Medium Volume (mL): 300
Medium pH: I%

Medium Viscosity [g/[cm™s)): I 0.007
Instrument Speed [RPM): I 75
I 7.504

Fluid ¥elocity [cmis):

Dissolution Phase |

Medium Composition |

SimulationsPlus
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Open the Valproate DDDPlus database project in DDDPlus (File=>Open Formulation
Database)
* Let’s perform a query and select only those records with the keyword ‘Opt’ — go to
the ‘Database—>Select Subset by’ menu
* We are going to build a DDDPlus model by optimizing parameters across the 2
records
— Go to the ‘Modules—=>Optimization—>1 Select Parameters and Objective
Function” menu
— Let’s make sure to ‘Match Predicted vs. Observed for All Records’
— Select the Valproate Calibration Constant (Formulation tab) and the HPMC
K15M Exponent N (Release Exponent tab)
* Validate the model by using the same parameters to predict the remaining

formulations
SimulationsPlus
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Fast Release - Opt
[ — Valproate-% Diss___[V W Valproate-% Diss Obs |

! Optimization Status = O X %
variable Initial Value Current Yalue ~ 80
valproate Calibration Constant 1 445885634131 744E-02 70
HPMC K15M Exponent N 0.8 0.906735987968145

Optimizing: Explore: 2968 60
Last Obj: 6.061723E-2 |
Best Obj: 6.061644E-2 ]
Stepsize(Pass=1) = 1.5263E-5
OhjAmtDiss = 6.062E-2 ] 30
Rsq Amt Diss (12) = 0.986455 DDDPlus X : 2

10
Optimization converged. 2/25/2020 5:01:06 PM 0

40

Percent Dissolved (%)
3

0 500 1,000

it Time (min)

e f

Slow Release - Opt

[ —— Valproate-% Diss. ¥ W Valproats-% Diss Obs |

Stop F g
Optimization | g 60
g 40

Calibration Constant = 4.4589E-2 £ 30 ]
Release Exponent =9.0674E-1 »
10

0 500 1000 : ’
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Slightly Fast Release

[[¥ == alproate-% Diss [ B Valproate-% Diss Obs |

100 |

80

70

Percent Dissolved (%)
S

&

10

0 500 1,000
Time (min)
50 SimulationsPlus
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HPMC

— Navigate to Slightly Fast Release record; update to optimized values of calibration
constant of valproate and release exponent of HPMC K15M

— Go to the Simulation tab and select ‘Virtual Trial’

- Choose the Valproate amount and set the CV% = 3%
- Choose the Lactose amount and set the CV% = 15%
- Choose the HPMC amount and set the CV% = 15%

— We will generate 25 virtual lots and run the simulation

* Let’s review the variability around the dissolution profile. Can we use
these results to assess the variability around the PK curves in GastroPlus?

51 SimulationsPlus
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B8 virtual Trial

Farameter Lower Limit tean Y alue Jpper Limit 4 Diigtribution

Celect " alproate At [rma) . 53d 5aa.7 Log-Mormal
Parameters Lactose Amt [ma] 122.4 132 3mA 15 Log-Mormal
HFMLC K158 Amt [mg] 172.2 270 423 4 15 Log-Mormal

e Define the parameters, mean value, CV%

and distribution type Virtual Trial Slightly Fast Release

* Export the virtual trial simulated B 90% Cean ean Dissoluton
dissolution variability to GastroPlus (new): Probabilty 75 % Probabity 50 % |
. . F'rubﬂbil'g 25 Prubﬂﬁv 10 %
Right click on the graph and Export o

Simulated Data to GastroPlus .dsd File 05

* Inthe next section, we will run virtual &
bioequivalence studies to determine if the 5
dissolution method variability is within
bioequivalence (Maximum and Minimum
Profile vs Mean Profile)

Fercent Dissolved (%)
(5]
[

Copy Data to Clipboard

Copy Image to Clipboard

Export Simulated Data to GastroPlus .dsd File
Export Observed Data to bastroPlus .dsd File

I2|:I|'|:|' I I4|:I|'|:|' I Iﬁl:ll'l:l' I IE':Il'I:l' - I1,|:|:|]'l:|'l I I1 ,ZII]I}I I I1 ,Jill]l}
52 Time (min) SimulationsPlus
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y Fast Release

Virtual Trial Slightl

I 50°% C.1. mean dissolutio
B Observed Mean

Probability 95 %
Probability 75 %
Probability 25 %

Mean Dissolution
Proba 00 %

Probability 50 %

Drobability 10 %6

Percent Dissolved (%)
en
=

Copy Data to Clipboard

Copy Image to Clipboard
Export Simulated Data to GastroPlus .dsd File
Export Observed Data to roPlus .dsd File

T T
200 400

T T T T
600 200 1,000 1,200
Time {min}

Virtual Trial - Slightly Fast - In Vitro Dissolution

2 o o o5
& & 83 8

% Dissolved In Vitro

o
o

o

T
1,400

53

—8—Mean —@—Max —8&—Min

10 15 20
Time [h]

® Observed In Vitro Dissolution

Take the Max, Mean,
and Min Profiles and
Convert them with
the Established IVIVC

y =-0.032+1.703x — 0.689x>

IVIVC - Slightly Fast - In Vivo Dissolution
120
100
80
60

40

% Dissolved In Vitro

20

0 5 10 15 20
Time [h]

—8—Mean —@—Max —@—Min

¥ = Human CR Slow-In Vivo Rel.
¥ = Human CR Fast-In Vivo Rel.
I WVIC Fit

Fraction

o 0.2 0.4 06 0.8 1
Fraction In Vitro Release

New automated conversion in 9.5!

[E Weibull Controlled Release Profile

File

Comments: |Vitual Trial Mean Profile - Active = Valproate - Data exported from DDDFlus Version 5.0.0011 -

e

Weibull Parameters——————————————————
Fit

1 (time lag) (hrs)|0 r
Max [total released) (%):[100 r

Fitting Weibull Function . |

Double Weibull Feni m (e m
f (fraction): [0E1824 ¥ [0.38176

A (time scale) (his™b): |8.0353 ¥ |4361.3 I3

b (shapel: [13071 | [36122

Percert relsased [%]

0 5 10 15 20

Fird Iritial | [ Time fhrs]
Estivates ||} SR Fiting f - Lancel | oK |

[ CAJsersEvaDocumentsTrainingsh2016-04 Mainz'W alpraats - DDDFluz - Pracict Shahtly Fasta/imuslT e ShahlyF as_T nabean.

™2 = 0.5
akaiks Information Criterion [4IC) = [4Pts) * LoalObi) + 2(#Parameters) = -270.0903
Schwarz Criterion (5C) = (#Pts) * Log{Obi) + (#ParametersFiLog(#F1s]) = -247.0021

SimulationsPlus
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goncunn O W

File Objective Function Weighting

Initro Data I Inivo Data I ¥IVC I LCorvolution

~Drug Records:
[ ] Select All o
Human CR Slow \:‘

uman CR Moderate

~ Status Window:

2nd Order Polynomial Function:
y= 0032 +1.703 %% +-0E33* (42
where x = Fraction in vitro release and y = Fraction in vivo release

~Deconvolution Methods:
% Mecharistic Absorption Model (G astroPlus]
" Numerical Deconvolution

" Loo-Riegelman [3-compartment model)

" Loo-Risgelman [2-compartment model)

" Wwagner-Nekson [1-compartment madel]

IVIVYC Procedure
’V(? Deconvolute Then Conelate ¢ Correlate Dirsctly (1 Step)
‘Weibull Function: Correlation Function:
Single Weibull

Pawer Function
Second Order Palpnorial
ird Ordesr P

- Plot: _
Cursor Pos - Ewﬂyaﬁ |—‘ Sl | S
K-ani

¥ x Human CR Slow-In Vivo Rel
W+ Human CR Fast-n Vivo Rel
12 VIVC Fit

| Plasma Concentration
] Fraction Absolute Bioav.

]
[ 1In Vi Release
[ Fraction Absorbed

[ irea Under Curve (4UC)

T T T T
Dther type of plot: T oz  oe o8 os 1 12
1 Lewy Plot Fraction In Vitro Release

Deconvolute

on
Carelation Stop | Savel\f\\lﬁl

" Logarithmic Scale % Linear Scale [ Hide Legend

’—Y—axis g: ‘

Correlation function from

Measured in vitro release

Tabulated Data Input

File Units | Tools |

In Vitro Dissolution Data File
Mo. of Data Points ) |E:\UxEIs\Eva\Ducumenls\Trainings\Zlﬂ 6-04 Mainz\¥alproate - I¥I¥C\Human CH

Mew Shghtly Fast.dsd
“Write comments here:

'Slightly Fast In Vit Dissalution ~ [ Interpalation Method
'In Vitro Amt [mg] = 500  Cubic 1.1E+2+
In Witro Vol [mL] = 900
'In Witro Sol [mg#mL] = 1 Linear
i Plot Typg———— 250l
@ Absolute
" Log =
4
&
3 55004
&
Time, h [% Released 2
. £
0.0 0.0 OK
1.0 7077 27.504
30 25.231 Cancel
50 38.769)
a0 £4.308)
12,0 93.345) Clear 0.008
18.0 100.0 (il &0 120 180 240
24.0 100.0 Time. h

.dsd

Sart Data on Time: |

IVIVC

Tabulated Data

File Units Tools

Expected in vivo release

Controlled Release Data File

No. of Data Paints 8 I

‘wirite: comments here:

Dissolution/Release profile in memory

.crd

Sort Data on Time |

Mean Profile cbtained from Vitual Tialin__ ~ | Interpolation Method
DDDPlus comverted to an in wivo profile with " Cubic 100,00
help to the established VYT
s Linear
i Plot Typg———— 75,004
&+ Absalute
" Log -
o
I
3 s
]
Time, h | Released oK <
3 3 ES
0.0 ] -
1.0 989 25,004
30 .25 Cancel
5.0 54.79)
a.0 23.08] [
ear
12.0 93.75) '4' 0.008
180 %19 0
24.0 93.2

[:11] 120 180 24.0
Time, h
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biowaivers) or to assist with formulation design activities

Traditional IVIVC methods determine the in vivo input rate to the systemic circulation (i.e., F% vs.
time — not absorption and not dissolution!)

The GastroPlus Mechanistic Absorption method allows you to separate in vivo dissolution of your
formulation from absorption & first pass extraction:

— Best estimate of the true in vivo dissolution/release of your product

DDDPIus was utilized to mechanistically predict the variability in dissolution through in silico

modeling — Able to appreciate the impact of changes to content uniformity on the dissolution
without guessing

Using the IVIVC established in GastroPlus, the ‘low limit” and ‘high limit’ dissolution profiles were
converted into in vivo release curves and used in virtual BE simulations — Establish dissolution
specifications by identifying the impact on predicted PK endpoints (Cmax and AUC)

SimulationsPlus
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Questions & Answers

GastroPlus

@B SimulationsPlus [=| Learn More! simulations-plus.com/gastroplus
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Modeling Controlled Release
Formulations in GastroPlus
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 Gastric release:

— Unreleased drug remains in stomach

* Integral tablet:

— Unreleased drug remains in tablet — moves

from one compartment to the next

(e.g., erosion tablet, pulsed, multi-layer
systems)

e Dispersed:
— Unreleased drug disperses among
compartments

(e.g., beads)

U = unreleased D = drug in solution

58
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— the whole tablet stays in stomach for
the period of stomach transit time

— after leaving stomach the dissolution
continues as for IR formulation

* Enteric Coated Capsule -

— the small enteric coated pellets can get
distributed throughout the Gl tract

— the pellets start leaving stomach
immediately at the rate calculated as
“1/transit time”

— Only the pellets that already left
stomach will start dissolving
(dissolution as for IR formulation)

Enteric coating — not user specified pH range

U = unreleased D = drug in solution
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